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CORRECTION  - C2I-1 - ETUDE DE CAS – SUJET 2006 

 
ETAPE 1 

Créez tout d’abord un nouveau dossier pour tous les documents de votre mémoire. 
Cliquez sur le raccourci qui affichera le contenu de votre PC 
Cliquer sur l’icône POSTE DE TRAVAIL 
 

 
 

ETAPE 2 

En un clic, agrandissez cette fenêtre 
 

 
 

ETAPE 3 

Affichez le contenu du dossier « Mes documents » (sans utiliser les menus) 
Double-cliquer sur le dossier « Mes documents » si visible ou Clic dans la barre d’adresse, puis 
Mes Documents 
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ETAPE 4 

Créez un nouveau dossier 
Cliquer avec le bouton gauche de la souris sur Fichier > Nouveau > Dossier 
 

 
 

ETAPE 5 

Créez un raccourci de ce dossier sur le bureau afin d’y accéder plus rapidement 
Cliquer avec le bouton droit de la souris sur « Mémoire », puis « Envoyer vers Bureau » 
 

 



Serge WACKER – http://www.montpellier.iufm.fr/technoprimaire/ 
 

3 

 
ETAPE 6 

Vous devez rechercher divers documents (images, textes…) sur Internet mais vous ne disposez 
pas encore d’une connexion. Parmi ces exemples, lesquels sont des fournisseurs d’accès à 
Internet ? 
� Free 
� Yahoo 
� Hotmail 
� Wanadoo 
� Google 
 
ETAPE 7 

Pour visualiser les pages Web, il est nécessaire d’installer un navigateur. Citez des navigateurs 
dans la liste ci-dessous : 
� Outlook Express  
� Mozilla Firefox 
� Club Internet  
� Opera 
� Internet Explorer 
 
ETAPE 8 

Si vous devez effectuer des recherches précises sur Internet, vous utiliserez plutôt : 
� un méta moteur de recherche 
� un moteur de recherche 
� un annuaire 
� un weblog 
 
ETAPE 9 

Si vous devez rechercher des informations variées dans un domaine assez vaste, vous choisirez : 
� un méta moteur de recherche 
� un moteur de recherche 
� un annuaire 
� un weblog 
 
ETAPE 10 

Indiquez des moteurs de recherche : 
� Google 
� Metacrawler 
� AltaVista 
� OpenDirectory 
� Free 
 
ETAPE 11 

Quels opérateurs booléens utiliseriez-vous pour affiner votre recherche : 
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� ET 
� OU 
� AVEC 
� PAS 
� SAUF 
 
ETAPE 12 

Dans votre moteur de recherche, comment afficher toutes les pages contenant exactement 
l’expression « amenagement durable du territoire » ? 
� Vous tapez : amenagement-durable-du-territoire 
� Vous tapez : amenagementdurableduterritoire 
� Vous tapez : « amenagement durable du territoire » 
� Vous tapez : [amenagement durable du territoire]  
 
ETAPE 13 

Cliquez pour formuler une requête complexe - Cliquer sur « Recherche avancée » 

 
 

ETAPE 14 

Limitez votre recherche aux documents PDF Limiter les résultats au format de fichier 
puis sélectionner à droite « PDF » 
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ETAPE 15 

Cliquez pour afficher seulement les pages françaises 
 Pages « France » 
 

 
 

ETAPE 16 

Vous venez de récupérer sur Internet une image du Pont du Gard. Vous pouvez l’utiliser pour 
illustrer votre rapport ou site personnel 
� si vous citez le site en bibliographie 
� si vous obtenez l’accord de son auteur 
� si vous obtenez l’accord du webmaster 
� sans restriction car une image diffusée sur Internet est toujours libre de droit 
 
ETAPE 17 

Vous allez consulter régulièrement ce site intéressant. Cliquez afin d’enregistrer son URL dans 
votre navigateur. 
Cliquer sur « Favoris », puis « Ajouter aux favoris » 

 
 

ETAPE 18 
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Pour télécharger ce document PDF le plus rapidement avec une connexion à 56K, vous allez : 
� cliquer sur le menu fichier dans la fenêtre du navigateur puis sélectionner « enregistrer 
sous » 
� l’ouvrir puis cliquer sur le « fichier » et « enregistrer sous » 
� faire glisser le lien vers l’emplacement choisi (disque dur, disquette…) 
� Faire un clic droit sur le lien et cliquer sur « enregistrer la cible sous… » 
 
ETAPE 19 

Vos recherches sur Internet terminées, vous passez à l’étape de rédaction du rapport. Lancez 
un logiciel approprié 

 
 

ETAPE 20 

Ajustez l’interligne du texte à 18 points exactement 
Format > Paragraphe > Interligne > 18 (le mot multiple apparaît) 

 
 

ETAPE 21 

Modifiez les marges du document (1/2) 
Fichier > Mise en page ou double-clic sur la règle 

Word 

Open Office Writer 
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ETAPE 22 

Modifiez les marges du document (2/2) 
 

 
 

ETAPE 23 

Créez un en-tête de page 
Affichage > En-tête de page et Pied de page 
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ETAPE 24 

En un clic, numérotez cette page 
Clic sur l’icône «Insertion avec un dièse #  

 
 

ETAPE 25 

En un clic, justifiez le texte  
Clic sur l’icône « Justifié » 

 
 

ETAPE 26 

Créez un style à partir du titre sélectionné 
Format > Style > Nouveau style 
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ETAPE 27 

Utilisez la barre d’outils du mode plan pour attribuer à ce titre le niveau 2 
 

 
 

ETAPE 28 

Ajoutez le numéro 1.1 à ce titre de niveau 2 (1/2) 
Format > Puces et numéros 
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ETAPE 29 

Ajoutez le numéro 1.1 à ce titre de niveau 2 (2/2) 
 

 
ETAPE 30 

Insérez une nouvelle page pour créer la page de garde de votre rapport. Celle-ci aura une mise 
en page différente des autres (1/2) 
Insertion > saut de Page 

 

 
ETAPE 31 

Insérez une nouvelle page pour créer la page de garde de votre rapport. Celle-ci aura une mise 
en page différente des autres (2/2) 
Fichier > Mise en page 

 
 
 
ETAPE 32 

Cliquez pour éviter la pagination de votre page de garde 
 Disposition – Première page différente 
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ETAPE 33 

Changez la police de ce titre 
Format > Police 

 
 

ETAPE 34 

Par précaution, vous allez sauvegarder ce document sur une disquette. Vérifiez d’abord sa taille 
(1/2) 
 Fichier  
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ETAPE 35 

Par précaution, vous allez sauvegarder ce document sur une disquette. Vérifiez d’abord sa taille 
(2/2) 

 
 

ETAPE 36 

Ce fichier peut-il contenir sur une disquette 3 pouces ½  
� oui si < 1,44 Mo 
� non si > 1,44 Mo 
� uniquement s’il est compressé 
 
ETAPE 38 

La première partie de votre mémoire est terminée et vous souhaitez l’imprimer. Installez 
d’abord une imprimante. 
Démarrer > Paramètres > Imprimante et télécopieurs 
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ETAPE 38 

L’imprimante que vous allez installer se connecte sur un port de type USB. Dans l’image ci-
dessous représentant les connecteurs d’un PC, indiquez le port USB 
 

 
 
ETAPE 39 

Sélectionnez l’imprimante par défaut  
 

 
 

ETAPE 40 

Choisissez l’imprimante « Lexmark Optra Color » pour imprimer le document (déjà installée) 
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ETAPE 41 

Imprimez cette page 
 

 
 

ETAPE 45 

Vous allez à présent utiliser un tableur pour organiser des données dans un tableau et les 
présenter sous forme d’un graphique. Afin de limiter les risques de perdre vos données en cas 
d’accident, activez la récupération automatique des informations 
Outils > options  
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ETAPE 43 

Sélectionnez toutes les cellules de la feuille 
 

 
 
ETAPE 44 

Cliquez pour ajouter une bordure aux cellules sélectionnées 
Bouton droit de la souris > Format de cellule > Bordure ou Menu Format, puis Cellule 

 
 

ETAPE 45 

En un clic, fusionnez les cellules 
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ETAPE 46 

Copiez la mise en forme de cette cellule 
Recopier le calcul en étirant la coin droit de la cellule 

 
 

ETAPE 47 

Cliquez pour modifier la largeur de la colonne E (sans utiliser les menus) 
Souris sur le trait vertical 
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ETAPE 48 

En un clic, calculer le nombre total d’exploitations pour le canton de Nîmes 
Clic sur l’icône « Somme » 

 
 

ETAPE 49 

Vous venez de copier le nombre exact d’exploitant pour Alès (calculé par une formule). Collez 
dans la cellule K9 uniquement le résultat de ce calcul (1/2) 
Copier / collage spécial 



Serge WACKER – http://www.montpellier.iufm.fr/technoprimaire/ 
 

18 

 
 

ETAPE 50 

Vous venez de copier le nombre exact d’exploitant pour Alès (calculé par une formule). Collez 
dans la cellule K9 uniquement le résultat de ce calcul (1/2) 
 

 
 

ETAPE 51 

Créez un graphique à partir des cellules sélectionnées 
Cliquer sur l’icône « Insérer graphique » ou Menu Insertion, puis Graphique 

Valeurs 
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ETAPE 52 

Ajoutez un titre au graphique (1/2) 
Cliquer sur Graphique, puis Option du Graphique 
 

 
 

ETAPE 53 

Ajoutez un titre au graphique (2/2) 
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ETAPE 54 

Modifiez l’aire du graphique 
Cliquer sur fenêtre graphique (une barre d’outils apparaît) 

 
 
 

ETAPE 55 

Centrez horizontalement le tableau et le graphique sur la feuille 
Cliquer sur Aperçu > Marges > Centrer > Horizontalement - verticalement 

Option du graphique 
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ETAPE 56 

Visualisez cette feuille dans son ensemble telle qu’elle sera imprimée 
Aperçu après avoir sélectionné les cellules ou Icône Aperçu 

 
 

ETAPE 57 

Après quelques semaines de travail, votre dossier « mémoire » contient un certain nombre de 
fichiers de format et taille différents. Vous allez effectuer quelques manipulations simples qui 
permettront de retrouver facilement vos données. Commencez par afficher le type et la taille 
des fichiers. 
Menu affichage > Détails  
Ou  
Cliquer avec le bouton droit de la souris sur l’icône « Propriétés » 
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ETAPE 58 

Triez les fichiers par type (en 1 clic) 
Affichage > réorganiser les icones par > type ou Onglet 

 
 

ETAPE 59 

Cliquez pour rechercher tous les fichiers textes 
Démarrer > rechercher > des fichiers > des documents textes  exemple : *.doc 

 
 

ETAPE 60 
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Pour afficher tous les fichiers commençant par un « M », vous taperez dans le champ : 
� M+ 
� M* 
� M 
� M ? 
� « M » 
 
ETAPE 61 

Vous souhaitez informer votre directeur de stage de l’avancement de vos travaux mais vous 
n’avez pas installé de logiciel de messagerie sur votre PC. Quel logiciel choisir (plusieurs 
réponses possibles)  
� Outlook Express 
� Hotmail 
� Eudora  
� Gmail 
� Wanadoo 
� Thunderbird 
 
ETAPE 62 

Créez une signature électronique 
Menu OUTILS, puis SIGNATURE  
 

 
 
  
ETAPE 63 

Cliquez pour entrer le nom du destinataire principal du message 
Cliquer sur « A » 
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ETAPE 64 

Cliquez pour envoyer une copie de ce message à un second destinataire 
Cliquer sur « Cc » - Copie Carbone  
 

 
 

ETAPE 65 

Vous devez envoyer plusieurs fichiers de format et taille différents à une même personne. 
Quelle est la meilleure façon de procéder ? 
 
� Vous créez et envoyez autant de messages qu’il existe de fichiers 
� Vous copiez les fichiers sur une disquette et l’envoyez par la Poste. C’est plus sûr 
� Vous compressez tous les fichiers dans un dossier et l’envoyez dans un seul message 
� Vous créez un dossier compressé pour chaque format et l’envoyez les dossiers dans des 
messages différents 
� Vous attachez tous les fichiers au même message et l’envoyez 
 
ETAPE 66 
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Cliquez pour envoyer un fichier avec ce message 
 

 
 

ETAPE 67 

Sélectionnez le fichier compressé 
 

 
 

ETAPE 68 

Ajoutez un contact au carnet d’adresse 

Icône Livre ou Menu Boite aux lettres  

Pièce jointe 
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ETAPE 69 

Transmettez ce message à une autre personne 
Transférer 

 
 

ETAPE 70 

Cliquez pour modifier les paramètres du serveur SMTP 
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ETAPE 71 

Une sélection de votre mémoire est l’objet d’un travail de groupe. Pour faciliter la mise en 
commun et l’échange des travaux, vous allez créer : 
 
� un espace dans un forum de discussion 
� un site personnel 
� un espace de travail collaboratif sur Internet 
� une liste de travail collaboratif sur Internet 
� une liste d’adresse des membres dans votre logiciel de messagerie 
 
ETAPE 72 

Citez des espaces de travail collaboratif 
� Mayeticvillage 
� Onlineformapro 
� Newgroup 
� Club-internet 
� Outllook 
 
ETAPE 73 

Concernant les espaces de travail collaboratifs, laquelle de ces propositions est fausse : 
� Les membres peuvent s’échanger tout type de fichiers 
� On y trouve généralement un forum 
� Les documents de l’espace sont stockés sur le disque du gestionnaire 
� Il est possible de restreindre l’accès à certaines ressources 
� La communication entre le membre peut-être synchrone 
 
ETAPE 74 

Comment communique en temps réel sur Internet avec d’autres membres du groupe ? 
� Vous utilisez un logiciel ou espace de « chat » sur Internet  
� Vous utilisez un système de visioconférence 
� Vous créez un espace dans un forum de discussion 
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� Vous créez une liste d’adresse dans votre logiciel de messagerie 
� Vous  utilisez  un logiciel de messagerie instantanée  
 
ETAPE 75 

Vous allez maintenant créer le diaporama de votre mémoire. Commencez par appliquer aux 
diapositives un ensemble de style (puces, polices, jeux de couleurs, …) 

Format, puis Conception ou onglet dans la barre de mise en forme 

 

 
 
 

ETAPE 76 

Cliquez sur l’icône qui vous permettra de dessiner une zone de texte 
 

 
 

ETAPE 77 

Insérez une image contenue dans le dossier « mémoire » 
Insertion > Image > A partir du fichier 
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ETAPE 78 

Ajoutez une nouvelle diapositive 
Insertion > Nouvelle diapositive 
 

 
 

ETAPE 79 

Choissez une mise en page comprenant deux espaces réservés : un pour un titre et un pour un 
contenu varié (image, tableau, …) excepté du texte 
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ETAPE 80 

Ajoutez des puces à ce texte 
Format > puces et numéros ou Icône  

 
 

ETAPE 81 

Faîtes apparaître la barre d’outils « dessin » 

Menu Affichage, puis barre d’outils, puis Dessin 

Ou 

 Clic avec le bouton droit sur un icône > dessin   
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ETAPE 82 

Cliquez pour dessiner un rectangle 
Formes automatiques > Formes de base 

 
 

ETAPE 83 

Formez un seul élément à partir des objets sélectionnés (1/2) 
Menu Dessin (en bas à droite) puis  Grouper 



Serge WACKER – http://www.montpellier.iufm.fr/technoprimaire/ 
 

32 

 
 

ETAPE 84 

Formez un seul élément à partir des objets sélectionnés (2/2) 
 

 
 

ETAPE 85 

Modifiez l’effet associé à la forme 20 
Clic avec le bouton droit de la souris sur l’effet 20 > Modifier 
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ETAPE 86 

Créez un lien hypertexte Insertion – Lien hypertexte 
Ou  
Sélection du texte > Clic avec le bouton droit de la souris > créer un lien hypertexte 
 

 
 

ETAPE 87 

Masquez cette diapositive 

menu Diaporama, puis masquer  

ou 

Bouton droit souris sur la diapo, puis masquer 
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ETAPE  88 

Cliquez pour imprimer deux diapositives par page 
Menu Imprimer > Document > 2 diapositives par page 
 

 
 

ETAPE 89 

Votre présentation est terminée. Visionnez  votre chef d’œuvre 

Touche F5 ou menu Diaporama, puis Visionner le diaporama 
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ETAPE 90 

Enregistrez ce diaporama au format HTML (1/2) 
Fichier > Enregistrer en tant que page Web 
 

 
 

ETAPE 91 

Enregistrez ce diaporama au format HTML (2/2) 
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ETAPE 92 

Vous décidez de créer un site Web pour diffuser le résultat de vos travaux. Pour cela, vous 
utiliserez un logiciel adéquat.  Parmi les logiciels ci-dessous, lesquels sont des éditeurs de pages 
Web ? 
� Adobe GoLive  
� Microsoft Publisher 
� Adobe Reader 
� Macromédia Dreamwaver 
� Openoffice Impress 
 
ETAPE 93 

Quel est le langage de formatage des pages Web ? 
� HTTP 
� HTML 
� Visual basic 
� C++ 
� PHP 
 
ETAPE 94 

Pour accélérer le temps de chargement des pages HTML, il est préférable d’inclure dans son 
site des images aux formats : 
� gif 
� zip 
� jpg 
� tiff 
� bmp 
 
ETAPE 95 

La lenteur de l’affichage de certaines pages Web cous incite à choisir une connexion haut débit. 
Quelle technologie haut débit utilise les lignes téléphoniques, 
� Le satellite 
� L’ADSL 
� Le câble 

Type de fichier : Web 
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� Il n’est pas possible d’utiliser les lignes téléphoniques pour les connexions haut débit  
 
ETAPE 96 

Vous vous décidez pour un accès ADSL. Votre fournisseur d’accès vous promet un débit maximal 
de 8 Mbits par seconde. Sachant que vous habitez à environ 3 Km du central téléphonique, quel 
débit pouvez-vous espérer ? 
� 8 Mbits/s car il n’y a pas de perte liée à la distance du central 
� Entre 2 et 6 Mbits/s 
� Moins de 2 Mbits/s 
� A  cette distance, vous ne pouvez pas avoir l’ADSL. Il faudra vous contentez de votre 
connexion bas débit 
 
ETAPE 97 

Vous allez autoriser le téléchargement d’une partie de vos travaux. Sous quels formats les 
fichiers  pourront-ils être disponibles ? 
� txt 
� pdf 
� jpg 
� zip 
� csv 
 


